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Introduction to Mudbox

CHAPTER 2

                                 If you are familiar with Maya, 3ds Max, Cinema 4D, or any other three-
 dimensional (3D) program, you will be right at home in Mudbox and will 
begin sculpting in a matter of minutes. However, if you are new to 3D and 
digital sculpting, Mudbox is still the perfect choice because of its artist-
friendly interface, shallow learning curve, and intuitive sculpting and painting 
workfl ows. In the fi rst part of this chapter, you will briefl y review important 
parts of the Mudbox interface like menus, tools, windows, and camera navi-
gation. After the interface overview, you will be reviewing the basics of 3D 
computer graphics. Then, you will complete the fi rst tutorial in this book that 
will introduce various sculpting tools, layers, and provide you with hands-on 
experience with Mudbox.    

 Interface Overview 
 Upon launching Mudbox, you will see the Welcome window, which provides 
quick access to the Learning Movies, the models that come with Mudbox, and 
any recent Mudbox fi les worked on. You may turn off  the Welcome window by 
checking the “Do not show this Welcome window again” option in the lower 
left corner. If you choose to turn it off , you will still have access to all of the 
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same data through the menus. For now, select the Basic Head model from the 
“Start a new sculpture section” in the Welcome window. You should see the 
Basic Head model in the scene as shown in  Figure 2.1 .   

 By default, you should be looking through the perspective camera into the 
scene, which is contained in the 3D View. The 3D View is one of three main 
views in Mudbox. The other two are the UV View and the Image Browser. The 
3D View is where you do sculpting and painting work, and it is analogous to 
viewports in other 3D programs. In most standard 3D modeling programs, 
you can view the scene through multiple cameras or viewports, but in 
Mudbox, there is one viewport. Nonetheless, you may use Mudbox’s camera 
bookmarks, which you will learn about later, to quickly switch between the 
camera views. Next to the 3D View tab is the UV View, which displays the UV 
coordinates of the selected model. The third tab is the Image Browser, which 
allows you to preview and organize images and assign them to various tools. 
For example, you could browse to an image on your hard drive, load it into 
the Image Browser for inspection, and then assign it to be used as a stencil to 
detail a model. The Image Browser is also useful for viewing specialized types 
of fi les such as image-based lighting fi les and displacement maps. 

 At the bottom of the interface, you will fi nd a collection of customizable trays 
that organize the Sculpt, Paint, and Select/Move Tools along with an assortment 
of trays for storing stamps, stencils, bookmarks, and various presets. The Sculpt, 
Paint, and Select/Move Tools comprise the three leftmost trays ( Figure 2.2 ). 
Faces and Objects are selection tools, and the Translate, Rotate, and Scale tools 
are collectively known as the  transform tools . You may customize any of the 
tool trays by adding, deleting, or renaming tools, as well as building custom 

 FIG 2.1    Mudbox Has a Standard, Intuitive Interface and Straightforward Sculpting and Painting Workfl ows.   
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trays with your favorite tools for quick access. The fi rst nine sculpting tools may 
be accessed by simply pressing the numbers 1 through 9 on your keyboard.   

 The fi rst two trays on the right organize images that can be used as stamps 
or stencils in conjunction with various sculpting and painting tools. Mudbox 
ships with an assortment of stamps and stencils, but you can create your own 
tools and add them to the trays. Next is the Falloff  tray, which stores presets 
that manage sculpting and painting tool profi les. At this point, it is worth 
mentioning that the falloff  parameter is an important property of the Mudbox 
tools because falloff s dictate the shape of the stroke created by the tool. In 
other words, the same tool with diff erent falloff s will create diff erent eff ects. 
The last three trays on the right are the material presets, lighting presents, and 
the camera bookmarks. 

 The next important area in the Mudbox interface is the tabs and windows to 
the far right of the interface. Starting at the top, there are the Layers, Object 
List, and Viewport Filters tabs. The Layers tab is composed of the Sculpt and 
Paint layers. You may add, delete, merge, and restack the sculpting layers as 
needed. These may also be locked, hidden, or have their eff ect attenuated by 
adjusting the layer opacity. Much of the work you will do in Mudbox is directly 
tied to managing the sculpting layers effi  ciently. The tutorial in the chapter 
will introduce you to layer basics, and the tutorials that follow will cover layers 
in detail ( Figure 2.3 ).   

 To switch to the paint layers, press the Paint button in the Layers tab. The paint 
layers organize the various texture types that may be painted on a model. 
For instance, you may paint several diff use textures, as well as specular, gloss, 
bump, and refl ection textures. Like the sculpt layers, the paint layers may also 
be restacked, locked, hidden, or have their opacity adjusted ( Figure 2.4 ).   

 FIG 2.2    Mudbox Features a Comprehensive Set of Sculpting and Painting Tools. The Main Selection Tools Are Faces and Objects, and the Translate, Rotate, 
and Scale Tools Comprise the Select/Move Tools.   
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 The Object List organizes, manages, and displays information about all of 
the objects in the scene including lights, cameras, and materials ( Figure 2.5 ). 
For instance, you may choose a diff erent camera to look through, as well as 
select, rename, or delete objects from the scene. Last in this set of tabs is the 
Viewport Filters. The fi rst three Viewport Filters simulate various render envi-
ronments through controls for lighting, depth of fi eld, and ambient occlusion. 
The Screen Distance fi lter displays a gray scale depth map of the model based 
on the distance from the camera. The Normal Map fi lter previews the normal 
map, and the Non-photorealistic fi lter simulates a sketchy render.   

 FIG 2.3    To Eff ectively Sculpt In Mudbox, You Must Learn to Manage the Sculpt Layers.   

 FIG 2.4    Paint Layers Organize the Diff erent Types of Textures, Such as Diff use, Bump, and Specular, that Mudbox 
Can Paint.   
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 Below the Layers, Object List, and Viewport Filter tabs is the Properties 
 window ( Figure 2.6 ). The Properties window is context sensitive in that it will 
display attributes of selected objects or tools. For instance, if you select 
the Foamy tool, all of the properties for that tool will be displayed in the 
Properties window; if you then select a camera from the Object List, then the 
properties for the camera are displayed. It is important to highlight the Size, 
Strength, and Mirror properties of the sculpting and painting tools. You will be 
referring to these properties a lot in the following tutorials.   

 FIG 2.5    The Object List Is the Central Hub Where You Can Find Information about Any Object In the Scene.   

 FIG 2.6    The Properties Window Displays Information about the Active Tool or Selected Object. The Strength, 
Size, and Mirror Properties Are Highlighted because They Are Often Used to Adjust the Mudbox Tools.   
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 The menu bar is located along the top left corner of the interface (see 
 Figure 2.1 ). These menus organize diff erent commands by task. The File and Edit 
menus organize standard fi le-management commands, as well as selection 
commands. The Create menu sorts all of the diff erent objects that may be 
created, and the Mesh menu provides quick access to subdivision commands. 
For now, we will skip over the Curves menu and move on to the Display menu. 
The top one-third of the Display menu holds the commands to hide and 
show objects, and the bottom two-thirds features commands for custom-
izing how objects are displayed and how the scene looks. You may access the 
commands in the bottom two-thirds of the Display menu by right-clicking 
anywhere in the scene. Next, the Maps menu has the commands for extract-
ing displacement maps, which will be covered in  Chapter 6 . And fi nally, the 
Windows menu allows you to display diff erent tabs as fl oating windows. Some 
users may prefer to have specifi c windows handy all the time – by selecting 
them from the Windows menu, the selected window persists in the interface. 
The Preferences command in the Windows menu allows you to customize 
just about every part of Mudbox. If you are using the Macintosh version of 
Mudbox, the menus are slightly diff erent. For example, the Preferences will be 
located in the Apple menu and not in the Windows menu. 

 Camera navigation is an integral part of working in Mudbox; it involves mov-
ing around the scene by panning, rotating, and zooming the camera. See 
Table 2.1 for hotkeys to navigate the camera. Later on in this chapter, you will be 
prompted to set up your graphics tablet. Once you have fi nished, you will use 
the buttons on the tablet’s stylus (pen) to navigate the camera throughout 
the scene. 

 A couple of last interface items that we will discuss are the Heads-Up 
Display (HUD) and the Status bar. When working in Mudbox, you will often 
see the HUD display important information about what you are doing. 
For instance, when you subdivide a model, the HUD will display the new 
number of polygons and subdivision level. Certain error messages are 
also displayed through the HUD, as well as information about different 
tools, like instructions when using stencils ( Figure 2.7 ). The far left end of 
the Status bar displays a blue progress bar that indicates how much of a 
specific operation has been completed. This is usually noticeable when 
performing operations that can be time consuming like when extract-
ing displacement maps. On the right side of the Status bar is information 
about the scene and, occasionally, you will see the far right end of the 
Status bar flashing to remind you to save your work (you can turn that off 
if you find it annoying).   

 In this section, you have briefl y reviewed the Mudbox interface, so that you 
can eff ectively work through the tutorial, later in this chapter. However, 
there is much more to the Mudbox interface that is not specifi cally covered 
here, but you will eventually come across many of those features later in this 
book. If you are curious now and want to know more, go to the Help menu 
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and select Mudbox Help and choose User Interface to learn more about the 
Mudbox interface.   

 What You Will Need to Work In Mudbox 
 To get the best results from Mudbox’s sculpting tools and painting brushes, 
you will need a pressure-sensitive graphics tablet. We recommend that you 
use a Wacom tablet. In fact, Autodesk lists a Wacom tablet as part of the 
system requirements for Mudbox. Wacom produces a wide variety of graph-
ics tablets for all levels of experience and budgets. Before starting work on 
the tutorials, launch Mudbox, go to the Help menu, select Mudbox Help, and 
complete the Tablet Setup instructions. The reason we are not guiding you 
through the tablet set up process is that set up for diff erent tablets may vary 
and you can customize how your tablet works. 

 Mudbox was developed to be used by a wide spectrum of users, including 
students, hobbyists, and professionals. Each type of user will require diff erent 
confi gurations of computer hardware, depending on how they use Mudbox. 
For the tutorials in this book, your computer should meet the minimum hard-
ware and operating system requirements listed for Mudbox on the Autodesk 
website. The reason your computer must have at least the minimum require-
ments is that to eff ectively sculpt in Mudbox, you will be working with models 
composed of hundreds of thousands and, sometimes, millions of polygons. 

 FIG 2.7    The HUD Displays Important Information about Current Operations.   
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Although Mudbox is optimized to effi  ciently manage very large polygon 
 datasets, you will still need the computer hardware that can handle the data. 
The tutorials in this book were designed so that almost anyone can complete 
the work with a standard computer that meets the minimum requirements.   

 A 3D Primer 
 Because Mudbox is a true polygonal modeler, it is important to understand 
some of the basics of 3D computer graphics. If you have experience work-
ing in programs like Blender, XSI, or 3ds Max, then you probably are already 
familiar with these concepts and may skip to the tutorial later in this chapter. 
However, if you are either new to 3D computer graphics, or a traditional sculp-
tor curious about digital sculpting, this section will introduce you to several of 
these important topics.  

 Understanding 3D Space 
 Like most standard 3D programs, Mudbox uses  x ,  y ,  z  coordinates to plot the 
location of objects within its virtual 3D world space also know as the  scene . 
Everything from the location of models, lights, and cameras, even how some of 
the sculpting tools work depends on the  x ,  y ,  z  coordinate system. The center 
of the coordinate system is called the  origin . At the origin, the value of  x ,  y , and 
 z  is 0. So, if an object that is located at the origin is moved 5 units along the 
 z  axes, the value of the  z  axis for that object changes from 0 to 5. In Mudbox, 
the  x  axis describes the horizontal plane (left/right),  y  axis describes the 
 vertical plane (up/down), and  z  axis describes the depth plane (front/back). 

 To see the coordinate system at work, try the following quick exercise. Launch 
Mudbox, and from the Welcome window, select the Basic Head model to 
insert it into the scene. Next, click on the Select/Move Tools tab in the bottom 
tray and choose Rotate. You should see the Rotate manipulator appear within 
the model. If you look closely at the Rotate manipulator, you will see the rota-
tion axes labeled  x ,  y , and  z , as seen in  Figure 2.8 . In the Properties tray, you will 
see three input fi elds (one for each axis) next to the label Rotate. Now, click 
anywhere in the scene and drag. Notice that the model is rotated as you drag 
but also notice that the values in the Rotate fi eld change. By dragging the 
mouse, you are interactively changing the  x ,  y ,  z  Rotate values. Finally, type a 
0 in each Rotate input fi eld. The model should go back to its original position. 
The Translate (move) and Scale tools work in a similar fashion. It is important 
to understand the underlying coordinate system because it describes the 3D 
space within Mudbox and aff ects just about everything within the scene.     

 Polygon Basics 
 Mudbox is a polygonal modeler, which means that the sculpting tools move 
the polygons that make up a model to change its shape. But what exactly 
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is a polygon? A  polygon  is a virtual 3D object that is composed of at least 
three vertices and three edges forming a triangle. However, a polygon that 
is composed of just vertices and edges is empty and usually invisible. To 
become visible, a polygon must be fi lled so that it can interact with virtual 
lights. Once fi lled, a polygon has a front face and back face. Typically, it is 
the front face of a polygon that can interact with virtual lights. This type of 
polygon is called a single-sided polygon, and it is the type of polygon that 
Mudbox displays. If a single-sided polygon is fl ipped, with the back face 
pointing toward the light, it becomes invisible again. To see the edges of 
the polygons that make up a model in Mudbox, referred to as the  wireframe , 
press W ( Figure 2.9 ).   

 When many polygons share their vertices and edges, a polygonal model is 
constructed. A polygonal model can be open like a plane or a closed volume 
like sphere. When working in Mudbox, you only need to be aware of polygon 
faces. Mudbox does not have any tools to directly manipulate vertices or 
edges. Mudbox works best with polygons that have four vertices and four 
edges, otherwise known as a  quadrangle  or  quad  in short.   

 FIG 2.8    You Can See the  x ,  y ,  z  Axes Labeled In the Rotate Manipulator. Also Notice the  x ,  y ,  z  Coordinate Input Fields In the Properties Window.   
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 Resolution 
 Another concept that is important to understand is resolution. In computer 
graphics, resolution can mean many things like how many pixels make up an 
image. However, in digital sculpting, the resolution of a model is determined 
by how many polygons make up the model. For example, a model with half a 
million polygons has a lower resolution than a model with a million polygons. 
The process of adding polygons or increasing the resolution is called  subdivi-
sion . Try the following quick exercise. With the Basic Head model in the scene, 
press W to display the wireframe. In the lower right corner status bar, you 
should see the number of polygons that make up the Basic Head model as 
2002. Now, press Shift + D to subdivide. Notice the total is now 8008 polygons 
and the wireframe is denser. Each time a model is subdivided, the number of 
polygons is multiplied by four. You can see how it would be easy to increase 
the resolution of a model into the hundreds of thousands if not millions of 
polygons with just a few subdivisions. To sculpt fi ne details, a high-resolution 
model is often required, but the higher the resolution, the more computer 
resources are needed to display the model ( Figure 2.10 ).     

 UV Mapping 
 UV mapping is a coordinate system that specifi es how an image texture is 
applied to a polygonal model. UV mapping uses the U and V axes to assign 
the pixels in an image to specifi c locations on a model. In Mudbox, a model 
does not have to be UV mapped to use the sculpting tools, but it must be UV 
mapped to eff ectively use Mudbox’s paint brushes. Mudbox can display UVs, 
but it does not have any tools to edit UVs. Consequently, if a model is imported 
into Mudbox for painting, it must be UV mapped in a separate program like 
modo. If you want to see a UV map, insert the Basic Head model into the scene 
and click on the UV View tab. Notice that the UV map is a fl attened 2D repre-
sentation of the model packed into the UV tile or space ( Figure 2.11 ).     

 FIG 2.9    Polygons Are Composed of Vertices and Edges. Filled Polygons Interact with Virtual Light, and When 
Many Polygons Share Vertices and Edges, a Polygonal Model Is Constructed.   
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 Digital Images 
 A digital image is a 2D grid or dataset that stores information as pixels (pixel 
is short for picture element); see  Figure 2.12 . For example, a picture taken with 
a digital camera is a digital image composed of pixels. Pixels store informa-
tion like color (RGB or CMYK), bit-depth (8, 16, or 32 bits), and transparency. 
Mudbox uses digital images in several ways. For instance, when painting a 
texture on a sculpture, Mudbox is creating a digital image. The stencils and 

 FIG 2.10    The Resolution of a Model Depends on How Many Polygons Compose the Model. The Model on the 
Left Has a Lower Resolution than the Model on the Right.   

 FIG 2.11    UV Mapping Is a Coordinate System that Specifi es How a 2D Image Is Applied to a 3D Model.   
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stamps are digital images, and Mudbox can also save screenshots of the scene 
as digital images of various formats.      

 Mudbox Hotkeys 
 You should become familiar with the following important keyboard shortcuts 
referred to as hotkeys. These hotkeys increase productivity and usability by 
allowing you to quickly access common commands or tasks while working 
(Table 2.1). There are many more Mudbox hotkeys, but for now, you need to 
know the ones in the list below. If you would like to see a complete hotkey list, 
go to the Help menu and choose Mudbox Help.   

 Quickstart Tutorial: Sculpting a Bell Pepper 
 The purpose of this tutorial is to introduce you to the basics of sculpting with 
Mudbox. This tutorial is designed for someone who has little or no experience 
with Mudbox, so it assumes that you don’t know anything about Mudbox or dig-
ital sculpting. If you have experience with Mudbox, you may want to skip to the 
sculpting tutorial in  Chapter 3 . This tutorial will cover fundamentals like camera 
navigation, several of the sculpting tools, sculpting workfl ow, layers, and stencils. 

 The subject of the sculpture in this tutorial is a bell pepper. This may seem like 
an odd choice for the subject of the fi rst tutorial, but the reason we chose a 
bell pepper is because it has a simple but recognizable shape that is forgiving 

 FIG 2.12    Digital Images Are Composed of a Pixel Grid. Each Pixel Stores Information Like Color and Transpar-
ency. Mudbox Uses Digital Images as Stencils and Stamps and Creates Digital Images When Painting Textures.  
 Photography by Christina Sizemore.  
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enough to allow you to focus on learning the sculpting workfl ow without 
worrying too much about details. You will sculpt the sphere model that comes 
with Mudbox into a bell pepper, so everything will be done within Mudbox 
without any imported models.  

 Setting Up the Scene 
 After launching Mudbox, you will see the Welcome window. In the “Start 
a new sculpture section,” scroll down until you see the Sphere and click to 
insert it into the scene. The default Mudbox scene displays a grid along the 
 x  and  z  axes and a gradient background. For the purposes of this tutorial, turn 
off  the grid and gradient by right-clicking anywhere in the scene (but not 
on the sphere), and from the contextual menu, uncheck Grid and Gradient 
Background ( Figure 2.13 ).     

TABLE 2.1 Hotkeys

Action Windows Hotkeys Mac OS X Hotkeys

Rotate camera Alt + left mouse button Option + left mouse button 
 command + left mouse button

Pan or Track camera Alt + middle mouse button Option + middle mouse button 
command + middle mouse button

Zoom or Dolly camera Alt + right mouse button Option + right mouse button 
command + right mouse  button

Roll camera Shift + middle mouse button Shift + middle mouse button

Focus Place cursor on the area of 
interest and press F

Place cursor on the area of interest 
and press F

Frame all A A

Adjust tool size B + left mouse button B + left mouse button

Adjust tool strength M + left mouse button M + left mouse button

Toggle Smooth tool Shift Shift

Invert Sculpting tool Ctrl Control

Add subdivision level Shift + D Shift + D

Step up subdivision level Page Up Page Up

Step down subdivision level Page Down Page Down

Invert Freeze Shift + I Shift + I

Unfreeze all Shift + U Shift + U

Undo Ctrl + Z Command + Z
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 Selecting and Scaling a Model 
 Next, you will select the sphere in the scene and scale it down (make it 
smaller). You may select the sphere either by clicking on its icon in the Object 
List or by choosing the Objects tool from the Select/Move Tools tray and 
clicking on the sphere in the scene, and once selected, the sphere will turn 
yellow. Next, choose the Scale tool from the Select/Move Tools tray. Notice 
that the Scale manipulator is displayed within the sphere. At this point, you 
may scale the sphere by clicking and dragging on any of the manipulator’s 
squares. However, clicking and dragging on the green, blue, or red squares 
will scale the sphere along one axis, resulting in an oval. In this case, the 
sphere should be uniformly scaled so that it retains its spherical shape. Click 
on the manipulator’s white middle square and drag until the sphere is about 
half of its original size ( Figure 2.14 ). An alternate method to scale the sphere is to 
do it numerically. To scale the sphere numerically, make sure that it is selected, 
choose the Scale tool from the Select/Move Tools tray, and in the Properties 
tray, enter the numerical value in the Scale input fi elds. In this case, you would 
enter .5 for each fi eld to scale down the sphere by 50%.     

 FIG 2.13    The Pepper Will Be Sculpted from Mudbox’s Stock Sphere Model. Insert a Sphere into the Scene and Turn off  the Grid and Gradient Background.   
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 Creating a Layer and Subdividing 
 Next, you are going to create the fi rst sculpting layer and subdivide the sphere 
in preparation for sculpting. A layer in Mudbox is an important tool that man-
ages the sculpting process. For example, you could rough in the basic shape 
of the pepper in one layer and then add details in another layer. If you don’t 
like the work you have done in the layer in which you sculpted the details, you 
can delete it, create a new layer, and try again without disturbing any of the 
work done in the fi rst layer in which you roughed in the basic shape. Mudbox’s 
layers are in many ways similar to layers in programs like Photoshop. As men-
tioned earlier in this chapter, subdividing the model means increasing the 
resolution or number of polygons that makes up the model. The reason the 
model is subdivided is to have enough polygons to eff ectively sculpt. You will 
learn more about layers and subdivision as you work through this tutorial; for 
now, follow these next steps to add a new layer and subdivide the sphere. 

 To add a new layer, click on the Layers tab, then click on Layers menu (the 
small, circular button with the arrow pointing to the right), and select New 
Layer. A new layer is created above the object-labeled sphere. Double-click on 
the layer to make the layer name editable and name the layer as Basic Shape. 

 Press Shift + D twice to subdivide the sphere two times. As you subdivide, 
notice that the HUD in the upper right corner of the scene displays the active 
subdivision level and number of polygons in the model. You should be in 
level 3 and the model should have 24,576 polygons. If you missed the HUD 
display (it fl ashes by quickly), look for labels “Total:” and “Active:” in the status 
bar at the bottom of the interface, and they should read Total: 24,576 and 
Active: 3 ( Figure 2.15 ). A key Mudbox feature is that you can move between 
subdivision levels. In this case, press the Page Down key to go down to level 2; 
now press Page Up to go back up to level 3.   

 FIG 2.14    Scale Down the Sphere by about 50%. You May Scale a Selected Object by Clicking and Dragging the 
Scale manipulator or by Numerically Changing the Values of the Rotate  x ,  y ,  z  Input Fields.   
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 An important feature about layers and subdivision levels is that layers only 
work with one subdivision level. In other words, if you are at subdivision level 
3 and begin sculpting in the layer Basic Shapes, then that layer is locked at 
level 3. So, if you subdivide again to level 4, you cannot sculpt in the layer Basic 
Shapes anymore and you would have to create a new layer to work at level 4.   

 Roughing In the Shape 
 At this point, the scene and sphere are set up, a new layer has been created, 
and the sphere has enough polygons to begin sculpting – so let’s get started. 
Make sure that you are working in the layer named Basic Shape by clicking on 
it once to make it active. Now, rotate the camera so you can see the top of the 
model. Select the Grab tool from the Sculpting Tools tray and set the Size of 
the Grab tool to about 50 and the Strength to 65. Position the Grab tool above 
the sphere (at the North pole) and move the Grab tool down to fl atten the 
sphere as seen in  Figure 2.16 . Repeat the process for the bottom of the sphere.   

 In this next step, you will mark the sections of the pepper. Peppers can have 
many sections, but to keep things simple, our pepper will have four. Rotate 
the camera so that you are looking down on the sphere and select the Bulge 

 FIG 2.15    Before Starting to Sculpt, Create a New Sculpt Layer and Subdivide the Sphere Twice.   
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tool. Set the Size to about 20 and the Strength to 65. But, before applying the 
Bulge tool, press Ctrl (Mac Control) and then create four indentations. Certain 
sculpting tools like the Bulge tool can be inverted by pressing the Ctrl key. 
This means that instead of pulling out when sculpting, the tool pushes in. 
Rotate the camera around to see the sides of the model and use the inverted 
Bulge tool to continue the indented marks to the bottom of the model 
( Figure 2.17 ). Don’t worry too much about making the indentions perfect; these 
are just guides for sculpting the sections of the pepper.   

 Now, you will shape the sections so that the sphere is even squattier. With 
the Grab tool set to about Size 50 and Strength 65, push in each end of the 
sphere. Reduce the Strength of the Grab tool to about 30 and shape the top as 
in  Figure 2.18 . Select the Bulge tool, set its Size to about 40 and Strength to 60, 
and sculpt the bumps at the top of each section. To delineate grooves between 

 FIG 2.17    Use the Bulge Tool to Mark the Sections of the Pepper. However, In This Case, You Will Invert the Bulge 
Tool by Pressing Ctrl While Sculpting to Sculpt Indentions.   

 FIG 2.16    To Begin Shaping the Sphere into a Pepper, Use the Grab Tool to Quickly Flatten the Top and Bottom.   
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the bumps, invert the Bulge tool, set it to a small size of about 15, and sculpt 
the grooves as seen in  Figure 2.19 . Focus on getting a feel on how the sculpting 
tools work; don’t fret too much over details. You may use the Smooth tool to 
soften or smooth out any bumps or lumps you don’t want. The Smooth tool 
may be accessed by selecting it from the Sculpt Tools tray or by pressing Shift 
to toggle to the Smooth tool while working with any other sculpting tool.     

 Rotate the camera so that you are looking at the bottom of the sphere. Use 
a combination of the Grab and the Bulge tools to create the features seen in 
 Figure 2.20 . At this point, the sphere should resemble a pepper, so we’ll refer to 
it as a pepper from now on. Rotate the camera so that the pepper is right-
side-up. Use the Grab tool to pull out the sides at the top of the pepper and 
push in the sides at the bottom. See  Figure 2.21 . You can do as little or as much 
reshaping as you like. Remember that peppers come in all shapes, so you can’t 

 FIG 2.18    With the Grab Tool, Push in the Sides of the Sphere Then Indent the Top.   

 FIG 2.19    Use the Pinch Tool to Delineate or Tighten the Grooves between Bumps and Sections.   
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get it wrong. Once you are fi nished shaping the pepper, use the Pinch tool to 
emphasize the grooves between each section. The Pinch tool moves polygons 
closer together, so when the tool is run along a groove, it makes the groove 
tighter. Select the Pinch tool and set its Size to about 10 and Strength to 30. 
In the tool properties, check the Steady Stroke option. Steady Stroke makes 
it easier to follow along a path. Run the Pinch tool along all of the grooves on 
the pepper to make them tighter and more distinct.       

 Sculpting Details 
 So far, you have sculpted a sphere into the general shape of bell pepper 
using the Grab, Bulge, Smooth, and Pinch tools. You have learned that some 
sculpting tools may be inverted by pressing the Ctrl key (Control Mac) so they 
push in instead of pulling out, and that the Smooth tool can be toggled on 

 FIG 2.20    Use a Combination of the Grab and Bulge Tools to Shape the Bottom of the Sphere. By This Point, You 
Should Be Getting a Feel of How the Sculpting Tools Work.   

 FIG 2.21    Use the Grab Tool to Give the Pepper Its Characteristic Bell Shape.   
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by pressing Shift while working with any other sculpting tool. You have also 
learned to manage the size and strength of the sculpting tools to get the 
desired amount of sculpting eff ect. In the next section of this tutorial, you will 
sculpt the fl oret and stem of the pepper with new tools like Freeze, Flatten, 
and Fill, and continue to practice with the sculpting tools that you have 
already been working with. 

 Before moving on to sculpting the fl oret and stem, add a new layer and name 
it Stem. In this way, you can practice sculpting the stem without disturbing 
the work you have already done to shape the pepper. If you mess up the stem, 
delete the Stem layer, create a new layer, and try again. After you have created 
a new layer, subdivide (Shift + D) the pepper twice to level 5. At this level, the 
pepper has 393,216 polygons. The added polygons will allow you to sculpt 
with the smaller details of the fl oret and stem. 

 In the following steps, you will use the Freeze tool to create a mask that will 
allow you to sculpt the stem. The Freeze mask will protect the masked areas, 
allowing the sculpting tools to work only in the unmasked areas. Rotate the 
camera so you are looking down at the pepper. Select the Freeze tool from the 
Sculpting Tools tray, set its Size to about 10 and Strength to 100, and paint the 
area shown in  Figure 2.22 . Now, press Shift + I to invert the Freeze. Make sure 
that you are working in the new Stem layer by clicking on it once to make it 
active.   

 With the Grab tool set to Size 20 and Strength 65, pull out the stem as shown 
in  Figure 2.23 . The Freeze mask is not necessary any more, so turn it off  by 
pressing Shift + U. Next, use the Smooth tool to smooth the base of the stem 
if necessary. You can shape the shaft of the stem by using any combination 
of the Grab, Bulge, and Smooth tools. Try experimenting with diff erent tools 
to see how they work together. The top of the stem can be shaped with the 

 FIG 2.22    Use the Freeze Tool to Paint the Area Where the Stem Will Be Sculpted. Then Invert the Freeze Tool to 
Freeze the Rest of the Pepper and Leave the Stem Spot Unmasked.   
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Flatten tool. If you like, you may turn off  the wireframe by pressing W. At very 
high subdivision levels, there are so many polygons that the wireframe is not 
useful.   

 The fl oret of the pepper is made up of very small, lumpy leaves. In the follow-
ing steps, you are going to suggest the fl oret without really sculpting all of 
the details. Use the Fill to fi ll in the area around the sections of the pepper and 
the stem, as shown in  Figure 2.24 . You may have to determine the appropriate 
Size and Strength for the Fill tool because your pepper and stem will probably 
be diff erent than what is shown in the fi gures. However, a Size of about 30 
and Strength of 25 is a good starting point. Next, use the Bulge and Wax tools 
to sculpt the lumps and bumps of the fl oret and use the Pinch tool around 

 FIG 2.23    Use the Grab Tool to Pull Out the Stem. Once Finished, Turn Off  the Freeze Mask and Shape the Stem.   

 FIG 2.24    Use the Fill Tool to Fill In the Area around the Stem. This Will Give You a Base to Sculpt the Floret. 
Then Use the Bulge and Wax Tools to Sculpt the Lumpy Leaves and, Finally, Use the Pinch Tool around the 
Edges to Delineate the Floret.   
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the edges of fl oret to separate it visually from the body of the pepper, as seen 
in  Figure 2.24 . At this point, you should have a recognizable sculpture of a bell 
pepper.     

 Adding Texture with a Stencil 
 Although the skin of a pepper may appear perfectly smooth, if you look 
closely, it has a slight texture. So, in these last few steps, you will add a texture 
to the skin of the pepper, using the Sculpt tool along with a Stencil. But fi rst 
things fi rst, create a new layer and name it Texture. As with the other two 
layers, adding this layer just for sculpting the texture preserves any work you 
have done so far and allows you to experiment without worry. 

 Select the Sculpt tool and set its Size to about 20 and Strength to about 5. 
Then, from the top row in the Stencils tray, choose the third image to the right 
by clicking on it once. If you hold the mouse over the stencil images, the fi le 
name is displayed; the one you want to choose is named bw_fi nestonedetail.
png. As soon as you select the stencil, it is displayed in the viewport along 
with a HUD that has instructions on how to manipulate the stencil image. In 
this case, the stencil should be smaller, so press S + RMB and drag to scale 
it down ( Figure 2.25 ). Next, click on the Sculpt tool once more to display its 
properties in the Properties tray and turn on mirroring across the  x  axis by 
selecting X from the Mirror menu. Mirroring allows the Sculpt tool to texture 
both sides of the pepper at the same time.   

 Now that everything is ready, start brushing with the Sculpt tool along the sur-
face of the pepper. You should see a texture appear underneath the sculpted 
area. Rotate the camera so that you can apply the texture on all of the pepper’s 
skin. Don’t worry if the texture appears very rough; apply the texture to all of 
the pepper’s skin, but try to avoid the stem and fl oret ( Figure 2.25 ). Once you 

 FIG 2.25    Use the Sculpt Tool with a Stencil to Add a Texture to the Pepper’s Skin. When Finished, the Texture Will 
Appear Very Rough.   
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are fi nished applying the texture, click on the Off  button in the Stencils tray. 
At this point, the pepper has a very rough skin. To remedy this problem, go to 
the layer named Texture and in the Opacity fi eld change the value from 100 to 
10. You should see the texture become very subtle as in  Figure 2.26 . The opacity 
property of the layer may also be changed by using the Opacity slider.      

 Summary 
 Congratulations on completing the fi rst sculpting tutorial. By this point, you 
should be familiar with the Mudbox interface and be able to locate the sculpt-
ing tools, the Layers tab, the Properties window, and navigate the scene using 
the mouse or stylus. In this tutorial, you used many of the sculpting tools and 
managed layers and subdivision levels to sculpt a bell pepper. That is quite 
an accomplishment for a beginner. And you have probably fi gured out that 
there are many possible ways to sculpt a bell pepper. Becoming profi cient 
with Mudbox requires practice, but the great thing about Mudbox is that it 
makes practice fun. In the next chapter, you will sculpt a portrait bust. You 
will take everything you have learned in this chapter and apply it to a more 
 challenging sculpture.   

 FIG 2.26    Use the Opacity Property of the Texture Layer to Reduce the Skin Roughness.   




